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1 Welcome

Welcome to Outlook Cleaner, the easiest way to manager your Outlook system and keep it trim and
fit.

Outlook Cleaner from PersonalCRM is a state of the art utility used to manage your Outlook folders.
Outlook Cleaner turns the dreary job of maintaining your folders into a snap.  With a few mouse clicks
in Outlook Cleaner, you can accomplish in minutes what could take hours in the native Outlook
environment.

With Outlook Cleaner you can:

· Review all Outlook folders at a glance, quickly identifying folders with excessive quantities.
· Remove all items from all folders based on filter criteria.
· Mass moves.  Consolidate items into one folder, based on filter criteria.
· Process items based on date, domain name, email address, subject and attachments.
· Save cleaning filters to be used over and over again.
· Run multiple cleaning jobs together in one batch job.
· Run cleaning jobs in the background from a desktop shortcut or as a Scheduled Task
· Create simple or complex migration schemes.  Periodically move aging items to aged folders

before removing them.

For support, we provide the following alternatives:

· Access our Free online Discussion Board and post any questions you may have.
· Send a support request to our staff via the PersonalCRM web. Our staff will reply to the request

within 48 hours
· Contact PersonalCRM at (408)773-9380. Extra charges may apply.

2 Introduction

Outlook Cleaner is a utility application designed to help you manage your Outlook system.  Using
Outlook Cleaner's filtering and processing options, you can quickly select hundreds or thousands of
Outlook items across any or all folders then, with one push of a button, remove them all from your
system.

· What's new with Outlook Cleaner

· Important information about using Outlook Cleaner.

· Outlook Cleaner requirements.

· How to obtain and install Outlook Cleaner

· Outlook Cleaner License Agreement

· Help using Outlook Cleaner.

· Contact PersonalCRM

http://www.personalcrm.com/discus/html/
http://www.personalcrm.com/problem_report.htm?product=Outlook%20Cleaner&versionnumber=3.0.0.xx&licensenumber=
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2.1 New Features

New features for Outlook Cleaner 3.0:

· Mass Moves  - Consolidate items into one folder based on filter criteria.

· Multiple Filter Entries - Match items to more than one entry for a filter condition.

· Saved Cleaning Profiles - Save filter criteria to named profiles to use over and over again.

· Batch Jobs  - Run multiple profiles from one batch job.

· Background Capabilities - Run profiles and batch jobs in the background using desktop shortcuts
or Scheduled Tasks.

New features for Outlook Cleaner 3.1:

· Text Search  - Include text string searches in your filters.

· Use Contacts - Include Contacts folder entries in your filters.

· Autorun  - Schedule profiles, or batch jobs to run periodically from the Outlook Cleaner interface.

2.2 Important!

While Outlook Cleaner features a simple easy to use and understand interface, the power of Outlook
Cleaner dictates that care should be exercised when using it.  While Outlook Cleaner makes it
possible to remove large quantities of unwanted e-mail with one mouse click, it also makes it possible
to remove large quantities wanted e-mail with one mouse click.

The user interface has been designed to be easy to use and understand and includes appropriate
precautionary warning messages.  Ultimately, however, the responsibility for using this product lies
with the user.  PersonalCRM accepts no responsibility for the misuse-use of this product leading to
the loss of data.

2.3 Requirements

Outlook Requirements:

· Outlook 2000 with service pack SR-1 or above
· Outlook 2002 - All versions

Operating System Requirements:

· Windows 98
· Windows 98 - SE
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· Windows Me
· Windows 2000
· Windows XP
· Windows XP Professional

Additionally:

· 10 MB of hard disk space
· Administrator Privileges if running Windows XP, XP Pro or 2000

2.4 Purchase and Installation

The following describes how to obtain, install and register Outlook Cleaner.

1. Purchase License
2. Download Software
3. Install Software
4. Register Software

Purchase License

Outlook Cleaner is made available through the Internet.

To purchase a license click here:  Purchase License

After purchasing, you will receive a confirmation e-mail containing a link to our download site and the
license number.  It is important to keep the license number as it is required to register the product.

Download Software

Use one of the following options to download Outlook Cleaner:

· Use the link provided in license purchase confirmation e-mail.
· Go to the PersonalCRM homepage:  http://www.personalcrm.com
· Click here:  Download Outlook Cleaner

You can also download Outlook Cleaner without purchasing a license, as a limited time
evaluation version.  The evaluation version can be upgraded to a registered version later.

Install Software

Double-click the downloaded executable file, OutlookCleaner31Setup.exe, and follow the installation
wizard instructions.

Register Software

Use the Register option of the Registration item in the Outlook Cleaner menu.  Enter the license
number received in your email confirmation of your purchase.  Make sure you are connected to the
internet and press Register.

http://www.regsoft.net/purchase.php3?productid=54857
http://www.personalcrm.com
http://www.personalcrm.com/CRM_Download.htm
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After registration Outlook Cleaner is now fully functional.

2.4.1 Evalutation Version

Try Before You Buy

The demonstration version of Outlook Cleaner you download from the Internet is 100% fully
functional.  All features are available but the Cleaning button will no longer function 15 days after you
install the product.

Upgrading Evaluation Versions

Evaluation versions of Outlook Cleaner can be upgraded to fully functional registered versions at any
time.

To upgrade an evaluation version:

1. Purchase a License
2. Register the evaluation version

2.5 License Agreement

OUTLOOK CLEANER LICENSE AGREEMENT - PERSONALCRM Inc.
        --------------------------------------------------------------

This is a user license agreement (the "AGREEMENT") between you (either individual or single entity)
and PersonalCRM, Inc., for the version of the software (the SOFTWARE") accompanying this
AGREEMENT.

The SOFTWARE is the property of PersonalCRM, Inc. and is protected by copyright laws and
international copyright treaties.  The SOFTWARE is not sold, it is licensed.

By availing of any of the rights licensed to you in this AGREEMENT, you agree to be bound by and are
becoming a party to this AGREEMENT.  If you do not agree to these terms and conditions, do not avail
of the rights licensed to you in this AGREEMENT.

If you accept the terms and conditions of this AGREEMENT, you have certain non-exclusive rights and
obligations as follow:
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If you accept the terms and conditions of this AGREEMENT, you have certain non-exclusive rights and
obligations as follow:

YOU MAY do any of the following:
· Use the Software for the Evaluation Period Provided;
· Use the Software for one SINGLE licensed computer only;
· Use the Software on a network, PROVIDED that each person accessing the Software through the

network must have a copy - licensed to that person or an authorized network
· multi-user license.

· Copy the Software for archival purposes ONLY, provided any copy must contain all the original
Software's proprietary notices.

YOU MAY NOT:
· Permit other individuals to use the Software except under the terms listed above;
· Distribute, reveal, post, or disseminate the license key to any other users;
· Permit concurrent use of the Software except with a multi-user license;
· Modify, translate, reverse engineer, decompile, disassemble (except to the extent applicable laws

specifically prohibit such restriction), or create derivative works based on  the Software;
· Copy the Software other than as specified above;

· Rent, lease, grant a security interest in or otherwise transfer rights to the Software
· Remove any proprietary notices or labels on the Software or its output;

All other rights with respect to the SOFTWARE are reserved.
The SOFTWARE is Copyright (c) 2001 PersonalCRM, Inc.
All Rights Reserved

The Software is provided "AS IS", without a warranty of any kind.
ALL EXPRESS OR IMPLIED i, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY
IMPLIED WARRANTY OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE
HEREBY EXCLUDED.  PERSONALCRM, INC. AND IT'SLICENSORS SHALL NOT BE LIABLE FOR
ANY DAMAGES SUFFERED BY LICENSEE AS A RESULT OF USING, MODIFYING OR
DISTRIBUTING THE SOFTWARE OR ITS DERIVATIVES. IN NO EVENT WILL PERSONALCRM,
INC. AND IT'S LICENSORS BE LIABLE FOR ANY
LOST REVENUE, PROFIT OR DATA, OR FOR DIRECT, INDIRECT, SPECIAL, CONSEQUENTIAL,
INCIDENTAL OR PUNITIVE DAMAGES,HOWEVER CAUSED AND REGARDLESS OF THE
THEORY OF LIABILITY, ARISING OUT OF THE USE OF OR INABILITY TO USE SOFTWARE,
EVEN IF PERSONALCRM, INC. HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

PERSONALCRM, INC. DOES NOT INDEMNIFY ANY PARTY TO THIS LICENSE.

IN ANY EVENT, THE MAXIMUM LIMIT OF PERSONALCRM, INC.'S LIABILITY UNDER THIS
AGREEMENT IS $1.

PERSONALCRM, Inc. is not bound by any provision of any purchase order, receipt, acceptance,
confirmation, correspondence, or otherwise, unless PERSONALCRM, Inc. is specifically agrees to the
provision in writing.  If any provisions, or portions thereof, of this agreement are invalid under any
applicable statute or rule of law, then that portion shall be deemed omitted in the applicable jurisdiction
and the remaining portions of the agreement remain in force.
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2.6 Help

You can obtain help for Outlook Cleaner in the following ways:

· Packaged help file. The help file provided with Outlook Cleaner is the most recent help when
this version of Outlook Cleaner was created. We also provide an online version of this help file
which may be more up-to-date than the shipped version.

· The online help file. This is the most updated version of the help file. To access it, click here.

· Printed Version of this Help File. You can download the PDF version of this help file from the
web by clicking here. You will need to have the Adobe .pdf reader installed on your system. To
download the Adobe .pdf reader, click here. To print the manual, click on the print button of the
.pdf reader and the manual will then be printed on your local printer.

· Outlook Cleaner Discussion Board. Participate on PersonalCRM's discussion board free of
charge and ask questions and exchange ideas with other users of Outlook Cleaner or other
PersonalCRM products. All discussion threads are monitored by PersonalCRM's personnel and
you will receive answers to questions that relate to product installation, setup, and use. To access
the discussion board, click here.

· Email Support . You can obtain free email support from PersonalCRM. Make sure that you
explain your problem/question with as much detail as possible. You can either send the email to
support@personalcrm.com, or use the support form by clicking here.

· Personalized, one-on-one support . PersonalCRM will provide personalized, one-on-one
support to paying customers. Support is provided on an hourly basis.

· Suggestions. PersonalCRM is driven to provide software solutions that will satisfy our customers.
Your input is important to us and we want you to contact us if you have any suggestions on added
features or even improvements we can make to our products in order to make them better.
Please click here to submit a suggestion .

2.7 Contact PersonalCRM.COM

PersonalCRM is committed to providing the best in ACT! and Outlook add-on software
packages.

Home page
http://www.personalcrm.com

Email support
support@personalcrm.com

Snail mail
PersonalCRM Inc.
891 Quetta Court
Sunnyvale, CA 94087

Fax
USA: (240)220-3244

http://www.personalcrm.com/outlookcleanerhelp/index.html
http://www.personalcrm.com/outlookcleanerhelp/OutlookCleaner.pdf
http://www.adobe.com/products/acrobat/readstep.html
http://www.salesbyweb.com/discus/html/
http://www.personalcrm.com/product_survey.htm?product=Outlook%20Cleaner%203.0
http://www.personalcrm.com
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3 Quick Start

This section walks you through a couple examples to quickly get up using the different features of
Outlook Cleaner.  The examples are:

1. Basic Delete
2. Basic Move
3. Use Date Filter.
4. Use Domain Name Filter.
5. Use Domain And Date Filters.
6. Use All Fields.
7. Use Any Field.
8. Create Profile.
9. Run Profile.
10. Create Batch Job.
11. Run Background Job.

See also:  User Interface, Using Outlook Cleaner

3.1 Basic Delete
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3.2 Basic Move
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3.3 Use Date Filter
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3.3.1 Use Date Filter - 2
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3.4 Use Domain Name Filter
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3.4.1 Use Domain Name Filter - 2
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3.5 Use Domain and Date Filters

3.5.1 Use Domain and Date Filters - 2
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3.6 Use "All Fields"

3.6.1 Use "All Fields" - 2
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3.6.2 Use "All Fields" - 3

3.7 Use "Any Field"
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3.7.1 Use "Any Field" - 2

3.7.2 Use "Any Field" - 3
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3.8 Create Profile

Profiles allow you to enter the filter criteria once then use the criteria many times.

To create a profile, start by setting up the conditions using the Folder Tree, Options Tab and
Filters Tab as described in any of the above example.  Stop at the cleaning step then do the following:
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3.9 Run Profile
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3.10 Create Batch Job
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3.10.1 Create Batch Job - 2

3.11 Run Background Job

Use background jobs to run saved profiles and batch jobs from desktop shortcuts or scheduled tasks.

To create a desktop short cut:

1. Create at least one profile and/or batch job as described above, Create a profile and
Create a batch job.

2. Create a Windows desktop shortcut: right-click the desktop and select New|Shortcut.
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3. Right click the shortcut and select properties.
4. Click the shortcut tab and into the target field enter:

"C:\Program Files\PersonalCRM\OutlookCleaner30\OutlookCleaner30.exe" -b BatchJob1

where BatchJob1 is the name of the batch job previously created.
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· You may also substitute -p for -b and use a profile name instead.
· You may use the -p and -b switches together and in any order.

· You may follow this procedure using Scheduled Tasks instead of short cuts to run regular updates.

4 User Interface

Outlook Cleaner features a single screen user interface from which all features are available.
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The main features of the Outlook Cleaner screen are:

· Folder Tree.
· Items List.

· Options Tab
· Filters Tab
· Profiles Tab
· Batch Edit Tab
· Clean Button
· Main Menu
· Current Folder Indicator
· Open Profile Indicator

· Status Bar

See also:  Using Outlook Cleaner, Quick Start

4.1 Folder Tree

The graphic representation of the Outlook folders.  Mark check boxes next to the folders to identify
them for cleaning.
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Features:

· View your Outlook folders.

· Determine the total number of items in each folder, sub folder or cumulations of sub folders.
· Determine the total number of selected items in each folder, sub folder or cumulation of sub

folders
· Expand and contract sub folders
· Select and deselect folders and sub folders for cleaning.

Folder Tree Behavior:

· When collapsed (i.e., no sub folders showing), folders show the cumulative total of items in the
folder and all sub folders.

· When expanded (i.e., all or some sub folders showing), folders show only the number of items for
the folder.  Sub folders totals are not included.

· When selected for cleaning (i.e., check box marked), folders are displayed in bold and show the
number of selected items:

· If expanded, folders show only the number of items in themselves.
· If collapsed, folders show the cumulative total of their items plus the items in selected sub

folders, even if the parent folder is not selected for cleaning.

· When selected, sub folders cannot be collapsed into their parent unless the
Collapse Marked Folders check box is marked.

· When selected, folders expand to display their sub folders.
· Click on '+' to expand folders.
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· Click on '-' to collapse sub folders.

4.2 Items List

Graphic representation of the Outlook items.  Items displayed depends upon the selected folders,
Sender Display, Folder Display and Show Selected and Unselected Options.

Features:

· Items selected for cleaning are highlighted in blue.

· Resize the items list window using the re-sizing bar to the left..
· Individual columns can be re-sized with the mouse by dragging the partitions between the column

heads.
· Control sort order of the rows by clicking on column headers.  Click a second time to toggle between

ascending and descending orders.
· Display how and which items are displayed using Options Tab features.
· Add Field Filters from the right click popup menu.
· Select and unselect individual items using the right click popup menu.

Caution:  The items displayed in the Items List window may not represent all the items to be cleaned,
depending upon the various option settings.
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4.3 Options Tab

Contains options for controlling display of and processing of Outlook items.
Divided into four frames: Cleaning Mode, Sender Display, Folder Display and Display Options.

1. Cleaning Mode - Select type of cleaning to perform:  Delete, Permanent Delete, Move.

2. Sender Display - Select how to display the sender field in the Items List:  Email Address, Sender Name, Domain Name.

3. Folder Display - Select folders to display in the Items List:  Current , Selected, All.

4. Display Options - Options to control display of Folder Tree and Items List.

4.3.1 Cleaning Mode

Select type of cleaning to perform:  Delete, Permanent Delete, Move.
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1. Delete - Move items to the "Deleted Items" folder.

2. Permanent Delete - Permanently remove items from Outlook.  Items are not recoverable.

3. Move - Move items to the Destination Folder.

See also:  Using Cleaning Mode

4.3.2 Sender Display

Select how to display the sender field in the Items List:  Email Address, Sender Name, Domain Name.

1. Email Address - Display the senders Email address in the Items List.

2. Sender Name - Display the senders name in the Items List.

3. Domain Name - Display the senders domain name in the Items List.

4.3.3 Folder Display

Select folders to display in the Items List:  Current, Selected, All.

1. Current Folder - Display the current folder.

2. Selected Folders - Display all marked folders.

3. All Folders - Display all folders.

4.3.4 Display Options

Options to control display of Folder Tree and Items List.
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1. Collapse Marked Folders - Allow marked folders in the folder tree to be hidden by collapsing them into their parent.

2. Show Selected Items - Causes items selected for cleaning to be displayed.

3. Show Unselected Items - Causes items not selected for cleaning to be displayed.

4. Include Subject Prefix - Causes subject prefixes such as fwd:, re: to be displayed.

5. Full Folder Path - Causes the entire folder path to be displayed in the Item List.

4.4 Filters Tab

Use the Filters Tab to access the three filter groups:  Date, Fields, Unread.
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1. Date - Use the Date Filter to select items by date.

2. Fields - Use Field Filters to precisely select items based on certain Outlook Fields:
Domain Name, Email Address, Sender Name, Subject Line, Attachments and

3. Unread Items - Include unread items in the filter.
Mark the Include Unread Items checkbox to include unread mail items in the filter.

See also, Using Filters
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4.4.1 Date Filter

Use the Date Filter to select items by date.

1. Absolute Date - Use an absolute (calendar) date in the filter.  Items must meet or precede the calendar date
to be included.

2. Relative Date - Use a relative (number of days) date in the filter.  The number of days old the item must be to
be included in the filter.

See also:  Using Date Filters

4.4.2 Field Filters

Use Field Filters to precisely select items based on certain Outlook Fields:  Domain Name,
Email Address, Sender Name, Subject Line, Attachments and Text.

1. Domain - Domain names included in the filter.

2. Sender Address - Sender address included in the filter.

3. Sender Name - Sender names included in the filter.

4. Subject - Subjects included in the filter.

5. Attachments - Attachment extensions to include in the filter set.

6. Text - Text within the message body to search for to include within the filter set.
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4.4.2.1 Domain Field Filter

Domain names included in the filter.

1. Suggested - Suggested values.  Taken from the default Inbox.

2. Applied - Values included in the filter.

3. Text Entry Box - Use to manually enter values into the Applied list box.

4. Filter On - Use to disable display of filter results in the Items List.  Uncheck to improve screen response
when using Text Field Filter.  Enabled only when using Text Field Filter.  No effect on actual
cleaning.

5. All Fields - Items must match each used field filter to be included.

6. Any Field - Items need only match one used field filter to be selected.

4.4.2.2 Sender Address Field Filter

Sender address included in the filter.
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1. Suggested - Suggested values.  Taken from the default Inbox.

2. Applied - Values included in the filter.

3. Text Entry Box - Use to manually enter values into the Applied list box.

4. Use Contacts - Use email addresses from contacts folders.  No other email addresses are are included in the
filter.

5. Filter On - Use to disable display of filter results in the Items List.  Uncheck to improve screen response
when using Text Field Filter.  Enabled only when using Text Field Filter.  No effect on actual
cleaning.

6. All Fields - Items must match each used field filter to be included.

7. Any Field - Items need only match one used field filter to be selected.

4.4.2.3 Sender Name Field Filter

Display the senders name in the Items List.



User Interface 36

© 2003  PersonalCRM, Inc.

36 

1. Suggested - Suggested values.  Taken from the default Inbox.

2. Applied - Values included in the filter.

3. Text Entry Box - Use to manually enter values into the Applied list box.

4. Filter On - Use to disable display of filter results in the Items List.  Uncheck to improve screen response
when using Text Field Filter.  Enabled only when using Text Field Filter.  No effect on actual
cleaning.

5. All Fields - Items must match each used field filter to be included.

6. Any Field - Items need only match one used field filter to be selected.

4.4.2.4 Subject Field Filter

Subjects included in the filter.
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1. Applied - Values included in the filter.

2. Text Entry Box - Use to manually enter values into the Applied list box.

3. Exact Match - Item's subject line must exactly match the filter, character for character.  If unchecked, a match
is made if the filter matches anywhere within the item's subject line.

4. No Alphas - Use to disable display of filter results in the Items List.  Uncheck to improve screen response
when using Text Field Filter.  Enabled only when using Text Field Filter.  No effect on actual
cleaning.

5. All Fields - Items must match each used field filter to be included.

6. Any Field - Items need only match one used field filter to be selected.

4.4.2.5 Attachments Field Filter

Attachment extensions to include in the filter set.
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1. Suggested - Suggested values supplied as defaults.

2. Applied - Values included in the filter.

3. Text Entry Box - Use to manually enter values into the Applied list box.

4. Filter On - Use to disable display of filter results in the Items List.  Uncheck to improve screen response
when using Text Field Filter.  Enabled only when using Text Field Filter.  No effect on actual
cleaning.

5. All Fields - Items must match each used field filter to be included.

6. Any Field - Items need only match one used field filter to be selected.

4.4.2.6 Text Body

Text within the message body to search for to include within the filter set.
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1. Applied - Values included in the filter.

2. Text Entry Box - Use to manually enter values into the Applied list box.

3. Clean Text - During filtering, search text body for a match and, if not found, remove non-alphanumeric
characters from text body and search again.

4. Filter On - Use to disable display of filter results in the Items List.  Uncheck to improve screen response
when using Text Field Filter.  Enabled only when using Text Field Filter.  No effect on actual
cleaning.

5. All Fields - Items must match each used field filter to be included.

6. Any Field - Items need only match one used field filter to be selected.

4.4.3 Unread Items

Include unread items in the filter.
Mark the Include Unread Items checkbox to include unread mail items in the filter.

4.5 Profiles Tab

Use the Profiles Tab to manage profiles, batch jobs and access the Batch Edit Tab
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Profile Buttons

1. Open - Open the selected profile.

2. New - Create a new profile.

3. Save - Save the current settings to the selected profile.

4. Close - Close the currently opened profile.

5. Cancel - Cancel the New profile operation.

6. Delete - Delete selected profile.  Access by right-clicking Profile list to activate popup menu.

Do not confuse Outlook Cleaner Profiles with Microsoft Outlook Profiles.

Batch Job Buttons
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1. Edit - Edit the selected batch job.

2. New - Create a new batch job.

3. Run - Run the selected batch job.

4. Delete - Delete the selected batch job.

4.6 Batch Edit Tab

Available List contains available saved profiles.  Used List contains saved profiles currently used by
batch job.
Use the Batch Edit Tab to add and remove Profiles to Batch Jobs.

1. Add - Include selected saved profiles in Available list into batch job.

2. Delete - Delete selected saved profiles in Used list from batch job.

3. Save - Save Used list into batch job and return to Profile Tab.

4. Cancel - Cancel changes to batch job and return to Profile Tab.
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4.7 Hot Keys

Hot keys are keyboard combinations that allow you to access screen controls without using a mouse.
Hot keys are identified by the underlined letter on the control.

Hold down the ALT key and press the keyboard key corresponding to the underlined letter to activate
the hot key.

4.8 Menu Options

Activate the Outlook Cleaner menu by pressing the <ALT> key or clicking on a menu item.
Additionally, menu items can be accessed via menu hot keys as indicated on the right of the menu
item.

n File

· Restore Columns:  Restore column widths to default.
· Reload Marked Folders:  Outlook Cleaner does not update for real time.  Updates are

conducted prior to cleaning.  Use this menu option to reload marked folders and update the
screen.

· Reload All Folders: Reload all folders even if not detected as out of date.
· Reload Current Folder: Reload Items from Outlook into Outlook Cleaner for the current folder.
· Clear Settings:  Remove filter settings and un-mark folders.
· Clear Filters:  Remove all filter settings.

· Unmark Folders:  De-selects all marked folder.
· Quit:  Quit Outlook Cleaner.

n Autorun - Periodically repeat functions Reload, Run Profile or Run Batch Job.  See Autorun
section.

· Update Folders:  Update Outlook Cleaner folders during the scheduled interval
· Run Profile:  Run the selected profile during the scheduled interval
· Run Batch Job:  Run the selected batch job during the scheduled interval
· 1 minute, etc:  Set the interval to 1 minute, etc.
· OFF:  Turn off Autorun

n Outlook Profile - Select the Microsoft Outlook Profile to run with background jobs.
Not to be confused with Outlook Cleaner Profiles.  If your Outlook installation allows multiple
profiles, e.g., the Corporate Workgroup installation, it may be necessary to assign the Outlook
Profile within Outlook Cleaner to suppress the Select Profile prompt when running background
jobs.
· Name:  The Outlook Profile name to use when running background jobs.
· Password:  If necessary, the password for the Outlook Profile.
· Clear:  Clear the name and password.

n Help

· Help:  Activate the Outlook Cleaner help system.
· Problem Report:  Opens the PersonalCRM Problem Report web page.
· Product Survey:  Opens the PersonalCRM Product Survey web page.
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· On-line help:  Most current version of the help manual.  Available via the Internet.
· About:  Display the Outlook Cleaner About Screen.

n What's This: Activates the What's This? help cursor.

n Registration

· Purchase:  Opens the Outlook Cleaner purchase web page.
· Register Outlook Cleaner:  Displays the registration screen.
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4.9 Miscellaneous

1.  Clean Button

Function depends upon Cleaning Mode setting:

1. Cleaning Mode is set to Deleted.
Press to delete items selected items.
Items will be placed in the deleted items folder.

2. Cleaning Mode is set to Permanent Delete.
Press to permanently delete selected items.
Items will be removed from the system and not be
recoverable.

3. Cleaning Mode is set to Move
Press to move selected items to destination folder.

4. Trial period has expired.
Cleaning options are not available.

2.  Current Folder Indicator

1. Indicates the Destination Folder in Move mode or else
the Current Folder. It is also the currently highlighted
folder in the folder tree.

3.   Open Profile Indicator

1. Indicates currently opened profile.
Blank if no open profile.

4.   Status Bar

1. Right half displays various status messages and
progressive counts during processing operations.
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5 Using Outlook Cleaner

1.  USING OUTLOOK CLEANER OVERVIEW

1.  Setup the cleaning profile:
· Cleaning Mode
· Filters
· Target Folders
· Destination Folder

2. Press the Clean button.

2.  ADDITIONAL FEATURES FOR USING OUTLOOK CLEANER

1. Cleaning profiles may be saved for reuse.
2. Profiles can be saved into batch jobs to run multiple profiles with one execution.
3. Profiles and batch jobs can be run automatically in the background using:

· Outlook Cleaner's Autorun feature
· Windows' shortcuts
· Windows' scheduled tasks

See also:  Quick Start, User Interface

5.1 Cleaning Mode

Cleaning Mode determines how Outlook items are processed by Outlook Cleaner.

1. CLEANING MODE OPTIONS

1. Delete Move items to the "Deleted Items" folder.

2. Permanent Delete Permanently remove items from Outlook.  Items are not recoverable.

3. Move Move items to the Destination Folder.

2. SET CLEANING MODE

1. Click the Options Tab
2. Select the Cleaning Mode from within the Cleaning Mode Frame.  Note changes to the

Current Folder Indicator and Clean button when different modes are selected.

See also:  Using Cleaning Mode
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5.2 Filters

Use filters to precisely select items within target folders for cleaning.

1. FILTER GROUPS
1. Date
2. Field

· Domain
· Sender Address
· Sender Name
· Subject
· Attachments
· Text

3. Unread

2. HOW ITEMS ARE SELECTED FOR CLEANING

1. Only items in Target Folders are considered.
2. If a Date Filter is used, items must meet Date Filter criteria to be selected.
3. If Field Filters are used, items must meet the Field Filter criteria to be selected.
4. If Include Unread is marked, mail items must be marked as unread to be selected.
5. The three filters (date, field, unread) are interdependent:  if the item fails the criteria of any one

filter, it is not selected.

See also:  Filters Tab

5.2.1 Date Filters

Use the Date Filter to select items by date.

1.  Date Filter Modes
1. Absolute Date - Filter allows you to enter a calendar date.  Any record that is at or precedes the

date is selected.
2. Relative Date - Enter a number of days.  Any record that is the entered number of days old or

older is selected.

2. Enter Absolute Date
1. Click the Filter Tab.
2. Click the Select Date check box within the Date Filter frame.
3. Click the Abs (absolute) date button.
4. Enter the desired date in the date text box in YYYY-MM-DD format.
5. Alternately, click the drop down button within the date text box and use the pop up calendar to

select the date.

3. Enter Relative Date
1. Click the Filter Tab.
2. Click the Select Date check box within the Date Filter frame.
3. Click the Rel (relative) date button.
4. Enter the number of days in the date text box.
5. Alternately, click the up and down buttons in the date box adjust the number of days.

See also:  User Interface Date Filter

5.2.2 Field Filters

Use Field Filters to precisely select items based on certain Outlook Fields:  Domain Name,
Email Address, Sender Name, Subject Line, Attachments and Text.
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1.   PROPERTIES

1. Field filters may contain multiple values.

2. Items need only match one value to be selected.

3. All Fields marked - Items must match each used field filter to be included.

4. Any Field marked - Items need only match one used field filter to be selected.

5. If no values entered, the field filter is ignored.

6 If no values in any field filter, all fields are ignored and all items are selected.,

7. Date filter and Unread filter conditions must also be matched for items to be selected.

2.   ENTER FIELD FILTER VALUES USING THE SUGGESTED LIST BOX

1. Click the Filters Tab
2. Click the fields tab for the desired field filter.
3. Select items in the Suggested box and press the ENTER key or
4. Instead of 3., select items in the Suggested box, right click the suggested box to activate the

pop-up menu and click Move or
5. Instead of 3 and 4, double click items in the Suggested box to move them down.

3.   ENTER FIELD FILTER VALUES USING THE TEXT ENTRY BOX

1. Click the Filters Tab
2. Click the fields tab for the desired field filter.
3. Enter the value in the Text Entry Box and press the ENTER key.

4.   ENTER FIELD FILTER VALUES USING THE ITEMS LIST POPUP MENU

1. Click on one item in the Items List so that it is selected.
2. Right click the Items List to activate the pop-up.
3. Click the field filter name from the pop-up to add the value of the selected item.

See also:  User Interface field filters

5.2.3 Unread Filter

Use the Include Unread check box to include unread items in the filter.

1. Include Unread Items.
1. Click Filters Tab .
2. Click Unread Items check box.

See also:  User Interface Unread Items Filter

5.3 Target Folders

Target folders are those folders containing items to be processed when the Clean button is pressed.

1. SELECT TARGET FOLDERS
1. Click the check box next to the target folder within the Folder Tree.  Note that selected folder

now appears in bold.
2. Repeat step 1.1 until all desired folders are selected.
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3. Click the folder check box as second time to unselect it.  Note the folder font face returns to
normal.

See also:  User Interface Miscellaneous

5.4 Destination Folder

The destination folder is the folder where the results of the cleaning action are deposited.

· The destination folder can be selected only when cleaning mode is Move.
· When cleaning mode is Delete, the destination folder is always the "Deleted Items" folder.
· When cleaning mode is Permanent Delete, there is no destination folder.

1. SELECT DESTINATION FOLDER
1. After all Target folders have been selected, click on the desired destination folder within the

Folder Tree.
· The Current Folder Indicator displays the destination folder.
· Do not check the check box.  The destination folder cannot also be a target folder.

See also:  User Interface Miscellaneous

5.5 Clean Button

1. Use Clean Button to execute cleaning.
2. Caption depends on Cleaning Mode.
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5.6 Profiles

Use profiles to save a set of filter conditions, cleaning mode and selected folders to be reused without
re-entering the settings for each use.

Reuse Profiles multiple times from the Outlook Cleaner Interface, as part of a Batch Job, using the
Autorun feature or as a background job.

1.  ADD PROFILE

1. Select the cleaning mode.
2. Setup the filter criteria.
3. Select folders to clean
4. Select target folder (if cleaning mode is Move).
5. Click the Profile Tab.
6. Click New under the Profile list box
7. Enter the new profile name in text box under the Profile list box.
8. Click Save under the profile list box.

2.  OPEN AND RUN PROFILE

1. Click the Profile Tab
2. Click the desired profile in the profile list box.
3. Click the Open button under the profile list box
4. Alternately:  Double click the profile in the profile list box instead of steps 2.2 and 2.3.
5. Click the Clean/Move button.

3.  CHANGE PROFILE

1. Open the profile to change as described in steps 2.1 - 2.4 above.
2. Make changes to settings as described in steps 1.1 - 1.4 above.
3. Click the Profiles Tab.
4. Click the Save button under the profile list box.

4.  OVERWRITE EXISTING PROFILE WITH NEW SETTINGS

1. Make settings as described in steps 1.1 - 1.4 above.
2. Click the Profile Tab.
3. Click the profile name to overwrite in profiles list box.
4. Click the save button under the profile list box.
5. Click "Yes" when prompted to overwrite the existing profile.

4. CLOSE AN OPEN PROFILE

1. Click the profile tab.
2. Click the Close button under the profile list box.

Note:  Closing a profile does not clear the filters and settings.  They remain set.  Use the Clear
Filters from the File main menu option.

5.  DELETE PROFILE

1. Click the profile tab.
2. Click the profile to be deleted.
3. Right click the profile list box to activate the popup menu.
4. Click the delete popup menu option to delete the profile.
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5. Click "Yes" when prompted to confirm the deletion.

See also:  Profiles Tab

5.7 BatchJobs

Use the Batch Job list box to add, delete and run batch jobs.  It also provides access to the
Batch Edit Tab, where jobs are created and edited.

Before you can work with batch jobs, you must have one or more profiles created.

1.  ADD BATCH JOB

1. Click the Profiles Tab.
2. Click the New button under the Batch Job list box.  The Batch Edit Tab is activated as the

Profile Tab is deactivated.
3. Highlight the Profiles in the Available list box to be included in the Batch Job.
4. Click the Add button under the Used list box.  Highlighted items are moved to the Used list box.
5. Alternately:  Double click Profiles in the Available list box to move them to the Used list box

instead of steps 1.3 and 1.4.
6. To remove profiles from the Batch Job, highlighted Profiles in the Used list box to be removed.
7. Click the Delete button under the Used list box.  Highlighted items are moved to the Available

list box.
8. Alternately:  Double click Profiles in the Used list box to move them to the Available list box

instead of steps 1.6 and 1.7.
9. Enter the Batch Job name in the Batch Job text box.
10. Press ENTER or click the Save button under the Used list box.  The Profiles Tab is activated as

the Batch Edit Tab is deactivated.  The new batch job name now appears in the Batch Job List
Box.

2.  CHANGE BATCH JOB

1. Click the Profiles Tab.
2. Click the Batch Job in the Batch Job List Box to be changed.
3. Click the Edit button under the Batch Job List Box. The Batch Edit Tab is activated as the Profile

Tab is deactivated.
4. Make changes in Batch Edit screen as described in steps 1.3 - 1.8 above.
5. Press Save under Used list box to save changes or Cancel to quit changes. The Profiles Tab is

activated as the Batch Edit Tab is deactivated.

3. OVERWRITE BATCH EXISTING JOB WITH NEW DATA

1. Create a new Batch Job as described in steps 1.1 - 1.8 above.
2. Enter the name of the existing Batch Job in the Batch Job text box.
3. Press ENTER or click the Save button under the Used list box.
4. Click "Yes" when prompted to overwrite the existing Batch Job.  The Profiles Tab is activated as

the Batch Edit Tab is deactivated.

4.  RUN EXISTING BATCH JOB
1. Click the Profiles Tab.
2. Click the Batch Job to be run in the Batch Jobs List Box.
3. Click the Run button under the Batch Job List Box.
4. Click "Yes" when prompted to run the Batch Job.  Batch Job is run.

5.  DELETE BATCH JOB

1. Click the Profiles Tab.
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2. Click the Batch Job to delete in the Batch Job List Box.
3. Click the Delete button under the Batch Job List Box.
4. Click "Yes" when prompted to delete the Batch Job.  The Batch Job is deleted and removed

from the Batch Job List Box.

See also:  Profiles Tab, Batch Edit Tab

5.8 Autorun

Use Autorun to update folders, open and run profiles or run batch jobs in intervals of 1, 5, 15 and 60
minutes.   After setting Autorun settings, minimize the Outlook Cleaner window to run in quasi
background mode.

1.  ENABLE AUTORUN MENU OPTIONS

Profiles and batch jobs must be closed to access Autorun menu options.

1. Close Open Profile.  Click the Profile Tab.  Press Close and/or Cancel profile commands.  A
blank Current Profile Indicator and blank and disabled profile text box indicate no open profiles.

2. Close Open Batch Job. The Batch Edit tab is available instead of the Profile Tab indicates a
batch job is open for editing.  Click the "Save" or "Cancel" button to close the batch job and
restore the Profile Tab.

2.  START AUTORUN

1. Select profile or batch job .   Click the Profile Tab.  Click a profile or batch job from the list box.
If selecting Update Folder job type in step 2, skip this step.

2. Select job type.  Click the Autorun main menu option.  Click Update Folders, Run Profile or
Run Batch.  You must select a profile or batch job as described in step 1 to enable the Run
Profile and Run Batch menu options.

3. Select time interval.  Click the Autorun main menu option.  Click 1, 5, 15 or 60 minutes.
Autorun is now set.

3.   CHANGE AUTORUN SETTING

1.  Change Profile or Batch Job.

1. Select profile or batch job as described in step 2.1 above.
2. Select job type as described in step 2.2 above.

You must perform both steps to change the Autorun setting.  Only selecting a new profile or batch
job does not change the Autorun setting.

2.  Change Time Interval.

1.  Select time interval as described in step 2.3 above.

4.  TURN OFF AUTORUN

1.  Click the Autorun main menu option.  Click the OFF menu option.  Autorun is now disabled.
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6 Examples

This section describes in detail three scenarios on how to do it. The purpose of these examples are
two give you an idea of the power of Outlook Cleaner.   For more details on the mechanics of
performing the tasks, see the Quick Start Section.  The following things are explained:

All of these examples involve setting up a series of related profiles and incorporating them into a batch
job.  Once created, the batch job can be run manually from the interface, run periodically from the
interface using the Autorun feature or run in the background using a desktop short cut or a scheduled
task.

1.  Basic Inbox Sort.  Put items know to be good into a Good Inbox folder, put Items known to be bad
(spam) into a Bad Inbox folder and put the remainder into an Inbox Pending (review) folder.

2.  Accounts.  Place records into specified folders based on domain name, email address and subject
line.

3.  Aging records.  Migrate items to progressively aged folders.

6.1 Process Inbox

SUMMARY:

Sort incoming email into three basic categories: Good, Bad and Pending

OVERVIEW:

Use various Outlook Cleaner filters to sort through your Inbox, identifying items known to be good,
known to be bad and moving the remainder to a pending folder.

SETUP:

1.    Create Outlook Folders

1. Open Microsoft Outlook
2. Create three new folders named Inbox - Good, Inbox - Bad, Inbox - Pending

Folder names are suggestions.  You can name them anything and put them anywhere in the folder
hierarchy.

2.   Setup Outlook Cleaner

1. Start Outlook Cleaner.  If already started, close and reload to load new folders.
2. Click the Options Tab.
3 Click the Move button within the Cleaning Mode frame.

3.   Create Contacts Profile

1. Click the Clear Settings option of the main menu File menu.
2. Click the Filters Tab.
3. Click the Email field tab.
4. Click the Use Contacts check box to that it is checked.  The Applied list box will be populated

by email addresses from your contacts folder.
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5. Click the Inbox folder in the folder tree so that the check box is checked.
6. Click the Inbox - Good folder without checking the check box.  The Current Folder Indicator

should say:  Destination:Inbox - Good.
7. Click the Profiles Tab.
8. Click the New button within the Profiles frame.  The profile name box is enabled.
9. Enter profile name into the Profile Name Box:  inbox-contacts.
10. Press ENTER or the Save button to save the profile.

4.   Create Good Items Profile

1. Click the Clear Settings option of the main menu File menu.
2. Click the Filters Tab.
3. Click the Any Field options button.
4. Click the Domain field tab.
5. Enter domain names of companies you frequently receive email from.  Do not enter generic

domains for ISP's such as AOL.COM or YAHOO.COM.  (hint:  Use the right click popup menu
from the items list to add items to your filter).

6. Click the Email fields tab.
7. Enter the email addresses for individuals you correspond with.  Do this only for addresses not

in your contact list and not covered by the domain filter.
5. Click the Inbox folder in the folder tree so that the check box is checked.
9. Click the Inbox - Good folder without checking the check box.  The Current Folder Indicator

should say:  Destination:Inbox - Good.
10. Click the Profiles Tab.
11. Click the New button within the Profiles frame.  The profile name box is enabled.
12. Enter profile name into the Profile Name Box:  inbox-addresses .
13. Press ENTER or the Save button to save the profile.

5. Create Spam Profile

1. Click the Clear Settings option of the main menu File menu.
2. Click the Filters Tab.
3. Click the Any Field options button.
4. Click the Domain field tab.
5. Enter domain names of companies you receive spam from.  (hint:  Use the right click popup

menu from the items list to add items to your filter).
6. Click the Email fields tab.
7. Enter the email addresses for individuals you receive spam from.  Do this only for addresses

not covered by the domain filter.
8. Click the subject tab.
9. Enter key words frequently found in the subject line of spam you receive.  Do this only for

email not covered by the domain or address filters.
10. Click the Inbox folder in the folder tree so that the check box is checked.
11. Click the Inbox - Bad folder without checking the check box.  The Current Folder Indicator

should say:  Destination:Inbox - Bad
12. Click the Profiles Tab.
13. Click the New button within the Profiles frame.  The profile name box is enabled.
14. Enter profile name into the Profile Name Box:  inbox-spam
15. Press ENTER or the Save button to save the profile.

6.    Create Spam Text Profile

1. Click the Clear Settings option of the main menu File menu.
2. Click the Filters Tab.
3. Click the Text field tab.
4. Enter key words frequently found in the body of spam you receive.  There may be substantial

overlap with the subject key words you entered in the previous spam filter (step 5.9).
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5. Click the Inbox folder in the folder tree so that the check box is checked.
6. Click the Inbox - Bad folder without checking the check box.  The Current Folder Indicator

should say:  Destination:Inbox - Bad
7. Click the Profiles Tab.
8. Click the New button within the Profiles frame.  The profile name box is enabled.
9. Enter profile name into the Profile Name Box:  inbox-spam-text

10. Press ENTER or the Save button to save the profile.

7.    Create Pending Profile

1. Click the Clear Settings option of the main menu File menu.
2. Click the Inbox folder in the folder tree so that the check box is checked.
3. Click the Inbox - Pending folder without checking the check box.  The Current Folder

Indicator should say:  Destination:Inbox - Pending
4. Click the Profiles Tab.
5. Click the New button within the Profiles frame.  The profile name box is enabled.
6. Enter profile name into the Profile Name Box:  inbox-pending
7. Press ENTER or the Save button to save the profile.

8.    Create Batch Job

1. Click the Profiles Tab.
2. Click the New button within the Batch Jobs (not Profiles) frame.  The Batch Edit tab is

activated.
3. Double click profile names in the order in the Available list box to move them to the Used list

box.  Order is important.   Enter them in the order you created them:
· Inbox-Contacts

· Inbox-Addresses

· Inbox-Spam

· Inbox-Spam-Text

· Inbox-Pending

4. Enter the name into the Batch Job name box:  inbox-1
5. Press Enter or the Save button to save the batch job.  The Batch Edit tab is closed and the

Profile Tab is reactivated.

9.   Schedule Batch Job

1. Click the Profiles Tab.
2. If there is an open profile, click the Close button within the Profiles frame.
3. Single click the Inbox-1 entry in the Profiles list box.
4. Click the Autorun main menu and select Run Batch entry.
5. Click the Autorun main menu again and select 15 minutes.

6.2 Process Accounts

SUMMARY:

Sort email  from business partners into various folders and sub folders, using domain names, email
addresses and subject lines.

OVERVIEW:

Assume three major business partners:  one customer (Mega Data Corp.),  one supplier (Parts-R-Us)
and one sub-contractor (Lowest Wages, Inc.).
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Use the following rules to file the email:

Mega Corp (megacorp.com)
· Email from the CEO (joe@megacorp.com) goes to the CEO subfolder but only after it has

been read.
· Customer Service Requests submitted via the company website, which are identified by

"CSR" in the subject line, are placed in the CSR subfolder.
· Everything else goes to the Mega Corp folder.

Parts-R-Us (parts-r-us.com)

· Emailed Invoices, identified by "INV" in the subject line, go to the Invoice sub folder of the
Parts-R-Us sub folder.

· Everything else goes to the Parts-R-Us folder.

Lowest Wages, Inc. (lowestwages.com)
· Everything goes to the Lowest-Wages folder.

SETUP:

1.   Setup Outlook folders.
1. Open Microsoft Outlook.
2. Create the following folders:

· Mega Corp
· CEO

· CSR
· Parts-R-Us

· Invoices
· Lowest Wages

2.   Setup Outlook Cleaner

1. Start Outlook Cleaner.  If already started, close and reload to load new folders.
2. Click the Options Tab.
3 Click the Move button within the Cleaning Mode frame.

3.   Create Mega Corp CEO Profile

1. Click the Clear Settings option of the main menu File menu.
2. Click the Filters Tab.
3. Click the Unread Checkbox so that it is unchecked.
4. Click the Email field tab.
5. Enter the CEO's email address, joe@megacorp.com, into the text box below the applied list

box and press ENTER.
6. Click the Inbox folder in the folder tree so that the check box is checked.
7. Click the CEO folder without checking the check box.  The Current Folder Indicator should

say:  Destination:CEO
8. Click the Profiles Tab.
9. Click the New button within the Profiles frame.  The profile name box is enabled.
10. Enter profile name into the Profile Name Box:  megacorp-ceo
11. Press ENTER or the Save button to save the profile.

4.   Create Mega Corp CSR Profile

1. Click the Clear Settings option of the main menu File menu.
2. Click the Filters Tab.
3. Click the All Fields button.
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4. Click the Domain field tab.
5. Enter the domain name megacorp.com into the text box below the applied list box and press

ENTER.
6. Click the Subject field tab.
7. Enter the subject key word csr into the text box below the applied list box and press ENTER.
8. Click the Inbox folder in the folder tree so that the check box is checked.
9. Click the CSR folder without checking the check box.  The Current Folder Indicator should

say:  Destination:CSR
10. Click the Profiles Tab.
11. Click the New button within the Profiles frame.  The profile name box is enabled.
12. Enter profile name into the Profile Name Box:  megacorp-csr
13. Press ENTER or the Save button to save the profile.

5.   Create Mega Corp Profile

1. Click the Clear Settings option of the main menu File menu.
2. Click the Filters Tab.
3. Click the Domain field tab.
4. Enter the domain name megacorp.com into the text box below the applied list box and press

ENTER.
5. Click the Inbox folder in the folder tree so that the check box is checked.
6. Click the MegaCorp folder without checking the check box.  The Current Folder Indicator

should say:  Destination:MegaCorp
7. Click the Profiles Tab.
8. Click the New button within the Profiles frame.  The profile name box is enabled.
9. Enter profile name into the Profile Name Box:  megacorp
10. Press ENTER or the Save button to save the profile.

6   Create Parts-R-Us Invoices Profile

1. Click the Clear Settings option of the main menu File menu.
2. Click the Filters Tab.
3. Click the All Fields button.
4. Click the Domain field tab.
5. Enter the domain name parts-r-us.com into the text box below the applied list box and press

ENTER.
6. Click the Subject field tab.
7. Enter the subject key word inv into the text box below the applied list box and press ENTER.
8. Click the Inbox folder in the folder tree so that the check box is checked.
9. Click the Invoices folder without checking the check box.  The Current Folder Indicator

should say:  Destination:Invoices
10. Click the Profiles Tab.
11. Click the New button within the Profiles frame.  The profile name box is enabled.
12. Enter profile name into the Profile Name Box:  parts-r-us-invoices
13. Press ENTER or the Save button to save the profile.

7.   Create Parts-R-Us Profile

1. Click the Clear Settings option of the main menu File menu.
2. Click the Filters Tab.
3. Click the Domain field tab.
4. Enter the domain name parts-r-us.com into the text box below the applied list box and press

ENTER.
5. Click the Inbox folder in the folder tree so that the check box is checked.
6. Click the Parts-R-Us  folder without checking the check box.  The Current Folder Indicator

should say:  Destination:Parts-R-Us
7. Click the Profiles Tab.
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8. Click the New button within the Profiles frame.  The profile name box is enabled.
9. Enter profile name into the Profile Name Box:  parts-r-us
10. Press ENTER or the Save button to save the profile.

8.   Create Lowest Wages Profile

1. Click the Clear Settings option of the main menu File menu.
2. Click the Filters Tab.
3. Click the Domain field tab.
4. Enter the domain name lowestwages.com into the text box below the applied list box and

press ENTER.
5. Click the Inbox folder in the folder tree so that the check box is checked.
6. Click the Lowest Wages folder without checking the check box.  The Current Folder Indicator

should say:  Destination:Lowest Wages
7. Click the Profiles Tab.
8. Click the New button within the Profiles frame.  The profile name box is enabled.
9. Enter profile name into the Profile Name Box:  lowest-wages
10. Press ENTER or the Save button to save the profile.

9.    Create Batch Job

1. Click the Profiles Tab.
2. Click the New button within the Batch Jobs (not Profiles) frame.  The Batch Edit tab is

activated.
3. Double click profile names in the order in the Available list box to move them to the Used list

box.  Order is important.   Enter them in the order you created them:
· mega-corp-ceo
· mega-corp-csr
· mega-corp
· parts-r-us-invoices
· parts-r-us

· lowest-wages
4. Enter the name into the Batch Job name box:  accounts-1
5. Press Enter or the Save button to save the batch job.  The Batch Edit tab is closed and the

Profile Tab is reactivated.

10.  Create Desktop Shortcut

1. Right click on the Windows desktop to activate the popup menu.
2. Click New then Shortcut to open the Create Shortcut Wizard.
3. Click the browse button.
4. In the Browse Folder window, click on My Computer then drill down until you get to

"C:\Program Files\PersonalCRM\OutlookCleaner30"
5. Scroll down to find OutlookCleaner31.exe, click on it then press OK to return to the Create

Shortcut window.
6. Click in the location field and press the END key to go to the end.
7. After the entry type -b accounts-1.
8. Location field now reads: "C:\Program

Files\PersonalCRM\OutlookCleaner30\OutlookCleaner31.exe" -b accounts-1
9. Press Next.
10. Enter Project X in the name field and press Finish.
11. You can now run the batch job any time from the desk top.

6.3 Process By Date

SUMMARY:
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Migrate items from the current item folder to progressively old items folders.

OVERVIEW

Email for Project X are kept in the Project X folder.  There are lots of them.  To better organize them,
sort them by date using the following aging criteria:

· Current
· Last Week
· 30 days
· Older than 30 days

To accomplish this, set up new folders, profiles, batch jobs and schedule the batch job to run as a
scheduled task.

SETUP:

1.   Setup Outlook folders.
1. Open Microsoft Outlook.
2. Use the current Project X folder as the current folder.
3. Create sub folders under the Project X folder:  Last Week, 30 Days, Over 30 Days

2.   Setup Outlook Cleaner

1. Start Outlook Cleaner.  If already started, close and reload to load new folders.
2. Click the Options Tab.
3 Click the Move button within the Cleaning Mode frame.

3.    Create the Over 30 Days Profile

1. Click the Clear Settings option of the main menu File menu.
2. Click the Filters Tab.
3. Click the Select Date check box so that it is checked.
4. Click the Rel (relative date) button
8. Click the 30 Days folder in the folder tree so that the check box is checked.
9. Click the Over 30 Days folder without checking the check box.  The Current Folder Indicator

should say:  Destination:Over 30 Days
10. Click the Profiles Tab.
11. Click the New button within the Profiles frame.  The profile name box is enabled.
12. Enter profile name into the Profile Name Box:  project-x-over-30-days
13. Press ENTER or the Save button to save the profile.

4.    Create the  30 Days Profile

1. Click the Clear Settings option of the main menu File menu.
2. Click the Filters Tab.
8. Click the Last Week folder in the folder tree so that the check box is checked.
9. Click the 30 Days folder without checking the check box.  The Current Folder Indicator should

say:  Destination:30 Days
10. Click the Profiles Tab.
11. Click the New button within the Profiles frame.  The profile name box is enabled.
12. Enter profile name into the Profile Name Box:  project-x-30-days
13. Press ENTER or the Save button to save the profile.

5.    Create the  Last Week Profile
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1. Click the Clear Settings option of the main menu File menu.
2. Click the Filters Tab.
8. Click the Project X folder in the folder tree so that the check box is checked.
9. Click the Last Week folder without checking the check box.  The Current Folder Indicator

should say:  Destination:Last Week
10. Click the Profiles Tab.
11. Click the New button within the Profiles frame.  The profile name box is enabled.
12. Enter profile name into the Profile Name Box:  project-x-last-week
13. Press ENTER or the Save button to save the profile.

6.   Create Batch Job

1. Click the Profiles Tab.
2. Click the New button within the Batch Jobs (not Profiles) frame.  The Batch Edit tab is

activated.
3. Double click profile names in the order in the Available list box to move them to the Used list

box.  Order is important.   Enter them in the order you created them:
· project-x-over-30-days
· project-x-30-days
· project-x-last-week

4. Enter the name into the Batch Job name box:  project-x
5. Press Enter or the Save button to save the batch job.  The Batch Edit tab is closed and the

Profile Tab is reactivated.

7.  Create Scheduled Task

1. In Windows, click Start then Control Panel to open the Control Panel.
2. In the Control Panel, double click Schedule Tasks  to open the Schedule Tasks window.
3. In Schedule Tasks, double click Add Scheduled Task to start the Scheduled Task Wizard.
4. Click Next to open the application list.
5. Scroll down the application list to find OutlookCleaner31.exe and click on it then press Next.
6. Enter Project X in the name box, click on Weekly then press Next.
7. Enter a 8:00 am and click Monday then press Next.
8. Enter your Windows login password and confirm it.  Press Next.
9. Click the Open advanced properties check box so it is check and press Finish.  The Project X

scheduled task properties opens.
10. Click in the Run field then press the END key.  After the existing entry add the following:  -b

project-x.  Be sure to include as space.
11. Press OK to close.  You may need to re-enter the password.
12. Batch job project-x  will now run every Monday as 8:00 am.

7 Miscellaneous

7.1 Background Jobs

Use background jobs to get the most from your profiles and batch jobs:

· Run background jobs from desktop icons.
· Run background jobs as Scheduled Tasks.
· Run any combination of profiles and batch jobs in the background.

· Background job run quickly because they only load record for the relevant folders, unlike the
Outlook Cleaner screen, which loads all folders.

· You can create batch jobs from the Outlook Cleaner icon created by the installation by copying it to
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the desktop or Scheduled Tasks folder then adding the parameters.
· Use -p to indicate following items are profiles
· Use -b to indicate following items are batch jobs.

Examples of valid setups:

To run Profile1 in the background:

"C:\Program Files\PersonalCRM\OutlookCleaner30\OutlookCleaner30.exe"  -p Profile1

To run BatchJob1 in the background:

"C:\Program Files\PersonalCRM\OutlookCleaner30\OutlookCleaner30.exe"  -b BatchJob1

To run Profile1 then BatchJob1:

"C:\Program Files\PersonalCRM\OutlookCleaner30\OutlookCleaner30.exe"   -p Profile1 -
bBatchJob1

To run several profiles (P1, P2) followed by several batches (B1, B2)  followed by several more profiles
(P3, P4):

"C:\Program Files\PersonalCRM\OutlookCleaner30\OutlookCleaner30.exe"  -p P1 P2 -b B1 B2
-p P3 P4

To run several batches (B1, B2) followed by several profiles (P1, P2)  followed by several more
batches (B3, B4):

"C:\Program Files\PersonalCRM\OutlookCleaner30\OutlookCleaner30.exe"  -b B1 B2 -p P1 P2
-b B3 B4

See the Quick Start section for more information on background jobs.

7.2 Multiple Instances

It is not recommended to run more than one instance of Outlook Cleaner at one time.  If you do, you
will receive the following message:
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You will also see this message if Outlook Cleaner starts and a background job is already running.
You can verify the background job by the presence of the Outlook Cleaner icon in the system tray part
of the Windows taskbar (usually lower left, next to the clock).

If Outlook Cleaner is already running, you should press Cancel to abort the new instance.

You will also get the error message if Outlook Cleaner did not close properly the last time it was used,
for instance if, if there was a system crash.  In this case, press OK to clear the message and to
continue loading Outlook Cleaner.

7.3 Performance

Working with large folders with thousands of items can cause Outlook Cleaner to perform sluggishly
when loading the Items List and changing filter criteria.  Some suggestions to make the system
perform better:

· Leave folders unmarked while setting filter criteria until you are ready clean.
· Unmask Show Selected Items and Show Unselected Items boxes until you are ready to clean.
· Run jobs in the background.

7.4 Using Help

Outlook Cleaner Help

Activate the Help system by pressing the F1 key or selecting Outlook Cleaner Help from the menu.

What's This? Help
Additionally, "What's This?" help provides control level help:

· Click the "What's This" menu option.
· The cursor changes to a question mark, indicating What's This? is active.
· Move the cursor over a control and click.
· The help for the control will display as a pop up.
· Click again to remove the pop up.

7.5 Uninstall

Use the Windows Add/Remove programs feature to uninstall Outlook Cleaner.

1. Select Control Panel from the start menu (or Start then Settings for Win98 users).
2. Select Add or Remove Programs.
3. Find and select Outlook Cleaner from the list.
4. Press the remove button.

Alternately, run the Outlook Cleaner installation executable and choose the Remove Application
option.
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7.6 FAQ

1. Why can't I find Outlook Cleaner on my Outlook menu?

Outlook Cleaner does not run from the Outlook interface.  Start Outlook Cleaner from the Start
Menu or the desk top icon.

2. Why doesn't the registration work on my notebook?  It worked fine on my desktop

Your license it good for only one computer.  To run Outlook Cleaner on a second computer,
you must purchase another license and obtain another unlock key.

3. How do I register my evaluation copy of Outlook Cleaner?

See Evaluation Version.

4. How do I get my serial number?

Select the About option from the Help menu item.
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